PREPARING ACCESS 2010 OR ACCESS 2007 FOR USE WITH PEARL

Summary: All changes must be made by an Administrative User. In Windows 7, UAC must be turned off to make the changes.

For Pearl to work correctly with Access 2010 or Access 2007, macros must be enabled either globally or at least for the Pearl file via
Trusted Locations. Also, you may need to follow additional steps for correct operation of the MSSOAP30.dll file to use Pearl Web
Services (eGrant Import and GuideStar Charity Check). If you have Pearl Access User Level Security, you must also reconnect each
workstation to the correct Workgroup file to reactivate the separate Pearl logon.

Basic Setup:

Before You Begin section includes important information.

Windows 7 users must turn off UAC to make the changes.

Vista users can proceed directly to the section on enabling macros.
Reconnect Pearl to security file if applicable.

Check code references in Pearl.

Test Pearl functionality with UAC off.

Once Pearl opens correctly, Windows 7 users must turn UAC back on.
Test Pearl functionality with UAC back on.

TITOomMmMoOO®P

Troubleshooting:
I.  Optional instructions are available for selectively enabling macros for Trusted Locations is on page 9.
J.  Troubleshooting the Microsoft Office Soap Type Library v3.0 reference starts on page 10.

BEFORE YOU BEGIN

= Pearl will not work in Office 2010 64-bit. When installing Office 2010, use the 32-bit installation option
(recommended by Microsoft) even on 64-bit Windows.

=  Be sure the latest service pack for Microsoft Office is installed on each workstation BEFORE opening Pearl. Microsoft
updates: update.microsoft.com (as of 10/1/2011: Office 2007 SP-3; Office 2010: SP-1*)

= |Install the latest Pearl update.
Pearl update: http://www.bromelkamp.com/Home/Support/SoftwareUpdates/tabid/73/Default.aspx

= |n Office 2010 the round Office button was replaced with the File menu, but the instructions remain the same.

= |n Office 2010, it may be necessary to change default expressions on form controls. If you encounter problems with F2 Find List
searches, please call Bromelkamp at (toll-free) 877-767-6703.

= All changes must be made by an Administrative user on the workstation of each Pearl user.

*Pearl users with custom reports which ask the user to choose a year or run a union query will need additional code fixes due to a
bug in Office 2010 SP-1. Please contact Bromelkamp Support at (877) 767-6703 or support@bromelkamp.com for assistance.
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WINDOWS 7 USERS ONLY - TURN UAC OFF (WINDOWS VISTA USERS CONTINUE TO NEXT SECTION)

The first step for you is to turn off the UAC (User Account Control) setting. It is EXTREMELY important that you remember to turn
this back on as soon as you have completed the rest of the steps described in this document. To turn off this control:

Ak

1. Click on the Start button in the lower left corner of the start bar on your computer:

2. Inthe Search box, type User Account; You should see a list
display that looks something like the screen example below.

3. Pick the Change User Account Control Settings option

4. Slide the Notify button from the mid-position down
to the Never Notify position. Click the OK button.

5. Reboot your computer. Then continue on

with the rest of this document.

Control Panel (18)

|$_, User Accounts
P Change User Account Control settings

82, Add or remove user accounts

Pé, Create standard user account

18 Configure advanced user profile properties
Documents (5)

@ Tires_Plus_Claim_Denial_of_Claim_Answer

MEW NRSC

Al 2005 taxes 5336

L_| WorldPer

Mactot10-21-2003

Files (8)
|| setup.inx
. Mac & Pat Bailey Accounts
£ | Regions (Karen + Dan 30th)
& | ATET Universal (Karen 11th)

p See more results

| User Account]

o — e

Choose when to be notified about changes to your computer

User Account Control helps prevent potentially harmful programs from making changes to your computer.
Tell me more about User Account Control settingd

Always notify
- - Default - Notify me only when programs try to make
changes to my computer
& Don't notify me when I make changes to Windows
- = settings
@ Recommended if you use familiar programs and visit
familiar websites.
Never notify

LT
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ENABLE ALL MACROS

Pearl must run with macros enabled to work properly. Enabling all macros is the

IMPORTANT: Later in this document
you will be instructed to turn the UAC

2. Open Access Options

simplest method.

(Please note: If you would prefer to enable macros only for the Pearl database,

please see the instructions for Trusted Locations.)

1. Open Microsoft Access without opening Pearl.

a. For Access 2007 - Click on the Office Button in the upper left corner, then click on the Access Options button.

b. For Access 2010 — Click on the File Tab on the left side of the screen, then select Options.

Recent Documents
New

Access 2007

2] Access Options

X Exit Access ‘

———

T

T
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3. Select Trust Center and click on the Trust Center Settings button

ﬂlé Papular
i P Help keep your documents safe and your computer secure and healthy, il
Current Database
Datasheet Protecting your privacy
B Chject Designers Microsoft cares about your privacy, For maore information about how Microsoft Office Access helps to protect your privacy,
please see the privacy statements. b
Proofing . . .
Show the Microsoft Office Access privacy statement L
Advanced Microsoft Office Online privacy statement B
Customer Experience Improvement Program la
Customize B
Sl Security & more :
;;“ Center : Learn mare about protecting your privacy and security from Microsoft Office Online, L
.
o Microsoft Windows Security Center
Microsoft Trustworthy Computing A
Microsoft Office Access Trust Center H
The Trust Center contains security and privacy settings, These settings help keep your computqr 5
secure, We recommend that you do not change these settings. Trust Center Settings... | L

4. In Macro Settings, select 'Enable all macros'

™ Trust Center

Trusted Publishers

=

Macro Settings

Trusted Locations . . .
For macros in documents not in a trusted location:

ol ™ Disable all macros without notification

™ Disable all macros with notification
Ih'lacm Seﬁings‘q -

= Disahle all marrns excent dinitally sioned macros

Message Bar ( O Enable all macras (not recommended; potentially dangerous code can runj ]

Privacy Options

5. Click OK twice to close the Trust Center and Access Options menus and save the changes
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RECONNECT USERS TO THE WORKGROUP FILE (IF APPLICABLE):

Pearl users will become disconnected from Pearl.mdw any time they open an Access database and the Pearl.mdw file is not
available. Common situations include:

. . Ik
e  Working on an off-line copy of Pearl at home over the weekend.

e Changing/installing Windows or Office on the computer. Create External Data

S %@ = HBE| 9 -3
Steps to reconnect to workgroup for each user:

Macros A<
1. Press F11 to reveal the Navigation Pane. |S-E'G!th.... P
2. Scroll down to the Macros & Autoexec

& PearlForm Autokeys

[i Pearl WorkgroupAdministrator ]

3. Find the macro Pearl WorkgroupAdministrator. Double-click on it.

4. The Workgroup Administrator dialog box will open, click Join
Workgroup Administrator

Mame: Avni
Comparny:  Bromelkamp Company LLC

Workgroup: C:\Users\Avni\AppData\Roaming\Microsoft\ Access
Y System.mdw

Your workagroup is defined by the workaroup information file that is used at
startup. You can create a new workgroup by creating a new information
file, or join an existing workgroup by changing the information file that is
used at startup.

’ Create... ]L Jain... J[ OK ]

5. Browse and then navigate to \\Pearl\System\Pearl.mdw.Select Pearl.mdw and click Open.

Workgroup Information File

Use the path and name below, or enter a different path and name for the new
workgroup information file.

Workagroup:
C:\0 MoBackup'Local Copiest\Systern\PEARL.MDW Browse...

[ (84 ] [ Cancel

6. Click OK. You should get a message that you have successfully joined the workgroup.

7. Reopen Pearl and log in as SecurityManager so that Pearl can copy necessary files to the workstation.
Logon -

Hame:

SecurityManager

Cancel

::::1:::1:'
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CHECK CODE REFERENCES IN PEARL

1. Open Pearl exclusively — you must be the only person in the Pearl Database to make these changes.
2. Press Ctrl+G to open the code window.
3. Inthe Tools menu, select References.
4. References should include only
e Visual Basic for Applications.

e Access 2003 Users: Microsoft Access 11.0 Object Library.
Access 2007 Users: Microsoft Access 12.0 Object Library.
Access 2010 Users: Microsoft Access 14.0 Object Library.

e  Microsoft DAO 3.6 Object Library.

e  Microsoft XML, v3.0. It is very important that XML v3.0 be selected and not version 2.0. You may need to scroll
down the list of references to find Microsoft XML, v3.0.

e  Microsoft Office Soap Type Library v3.0. To install this reference, please download and install the latest Pearl
update from the Software Updates page on the Bromelkamp website.

5. If you are missing any references, scroll down and select them. Once they are all selected, click OK.

6. Reopen the References window and check that the references are in the correct order. Use Priority arrows to change order
if necessary.

E Microsoft Visual Basic for Applications - Pearl - [PearMain (Code]] o || & || &
i¥8% Flle Edit View Insert Debug Run Tools Add-Ins Window Help Type a question for help -
Bla-d 4 23R 9 e rn @k ST Q z
Project - Pearl ] | Generan | |iDeclarations) |
== = "Pearl ***copyright 19%7-2005 Henry A. Bromelkamp, 2006-2011 Bromelkamp Company LLC 3
= 5 Pearl (Pearl)
1-[23 Microsoft Access Class Option Compare Database 'Use database order for string comparisons
= Modules COption Explicit
% PearlAccounting
+#2 pearlChanges Global Const Pea H in FormOpen)
References - Pearl =
« PearlCustom Global Const Pea
4 PearlFunctions Const PearlDLLVel Avaiable References:
«& PearlKernel
& PearlLoan Global Const Bror [ Visual Basic For Applications - Cancel
4 PearlMain icrosoft Access 14.0 Object Library E
«& PearlMenu Cakw QYDEG www icrosoft DAO 3.6 Object Library =
& Pearltil o Pearlcont icrosoft XML, v3.0 Browse...
Logd pearlWin32 ype PearlLontro, |l Microsoft Office Soap Type Library v3.0
[ Class Modules FldNum As In{ |[]AccessbiityCpladmin 1.0 Type Library + |
Next As Inteq |_|Acrobat fcal order
End Type [[] Acrobat Access 3.0 Type Library Priority
e EAcrobat Distiller Help
. Acrobat WebCapture 1.0 Type Library + |
Type PearlFieldIy |[aqobat webCapture IE Toolbar/Favorites 1.0 Type Lit
Parent As In{ |[]AcolfHelper 1.0 Type Library feld?

QryMame s 51 |ClActive DS Type Library
[ ActiveMnvie rontral tune thrans
End Type ke i e iy :

Type FilterInfor — AgControl 4.0 Type Library

FilterID ZAs ]

FilterName 2. Location:  c:\Program Files\Microsoft Siverlight\4.0.60831.0\npctrl.dll bd filter is chosen in the Filter dropli
Dirty As Boo Language: Standard new filter is created

ObjectType A tm, report, letter)

CbjectName &
ObjectRecordSource As String 'name of gquery used by the ObjectNams

"ChbjectRS As Recordset 'recordsetset by CbjectRecScurce
SourceqD As QueryDef "the recordset for the underlying
SQL &s String "the filter text (from source, like Navigator)

Filterarray() As String 'array that stores an inital filter for restoring after changes if needed
Frd Mima
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TEST PEARL FUNCTIONALITY (WINDOWS 7 USERS: UAC IS STILL OFF AT THIS POINT)

Open Pearl

If applicable, the user should login with their own Pearl username and password (type over SecurityManager)

Test your usual tasks, which may include data entry, reports, accounting, etc.

If you have any difficulties with Pearl, please reference the additional information starting on page 10 in this document.
Please contact Bromelkamp Support if you need assistance at (877) 767-6703 or support@bromelkamp.com.

WINDOWS 7 USERS ONLY — TURN UAC ON

The last step for you is to turn the UAC (User Account Control) setting back on. It is EXTREMELY important that you remember to

ok wN e

turn this back on as soon as you have completed the rest of the steps described in this document. To turn on this control:

£ ':'l 1
L/
1. Click on the Start button in the lower left corner of the start bar on your computer:

2. Inthe Search box, type User Account; You should see a list display that looks something like the screen example below.
3. Pick the Change User Account Control Settings option

4. Slide the Notify button from the Never Notify position back up to the mid-position (Notify me — Only when Programs try to
Make changes to my computer). Click the OK button.

-
%) User Account Control Settings Eléu

Choose when to be notified about changes to your computer

|l User Account Control helps prevent potentially harmful programs from making changes to your computer.
Tell me more about User Account Control settings

Always notify

-[ - Never notify me when:

® Programs try to install software or make changes to
my computer

* [make changes to Windows settings

@ Mot recommended. Choose this only if you need to
use programs that are not certified for Windows 7
- - because they do not support User Account Control.

MNever notify

[ ®ok [ cancel

5. Reboot your computer.
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TEST PEARL FUNCTIONALITY WITH UAC ON

Open Pearl

If applicable, the user should login with their own Pearl username and password

Test your usual tasks, which may include data entry, reports, accounting, etc.

If you have any difficulties with Pearl, please reference the additional information on the remaining pages of this document.
Please contact Bromelkamp Support if you need assistance at (877) 767-6703 or support@bromelkamp.com.

ok wnh e
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OPTIONAL: ENABLE MACROS FOR TRUSTED LOCATIONS ONLY

For more security in other Access databases, you may wish to set Macro Settings to Disable all macros with notification. Then, in

the Trusted Locations tab, add the Pearl folder as a trusted location. If Pearl is on a network server, be sure to check Allow Trusted
Locations on my network.

Trust Center

Trusted Publishers

Trusted Locations
Trusted Locations

Warning: All these lecations are treated as trusted sources for opening files. If you change or add a location, make

Trusted Documents sure that the new location is secure,
Description | Date Modified =~ |
Add-ins .
ser Locations
ActiveX Settings < WBROMELKAMPSERW ServerData\Pearlh, 10,31/2011 11:25 AM
CahsMicrosoft Office’ Officel 4\ ACC Access default location: Wizard Databases

Macro Settings
Policy Locations
DEP Settings

Message Bar

Privacy Options

Path: \WBROMELKAMPSERV ServerDatatPearl\,
Description:

Date Modified:  10,/31,/2011 11:25 AM
Sub Folders: Allowed

[ﬂdd new I.ocation...] [ Remove ] [ Medify...
]

:Allow Trusted Locations on my netwerk (not recommended

] Disable gt Frosted-+ +

[ ok || concel

When you add a new location, be sure to check Subfolders of this location are also trusted.

Microsoft Office Trusted Location

Warning: This location wil be treated as a trusted source for opening files. If you
change or add a location, make sure that the new location is secure.
Path:

\\BROMELKAMPSERV\ServerData\Pearl

‘Subfolders of this location are a@

DescripTiorT:

Browse...

Date and Time Created: 10/31/2011 11:25 AM

[ oK ] [ Cancel
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TROUBLESHOOTING: PEARL GUIDESTAR CHARITY CHECK OR EGRANT WEB SERVICE IMPORT DO NOT
WORK OR ERROR MESSAGE “METHOD ‘FULLPATH’ OF OBJECT ‘REFERENCE’ FAILED”

These errors mean the Microsoft Office Soap Type Library v3.0 (MSSOAP30.dll) reference is not registered with the correct path in
Pearl on a particular workstation. The steps below will need to be taken on each individual workstation which has the issue, even
though the reference is set in the shared database file.

Instructions to correct the path for the MSSOAP30.dll reference in Pearl
1. Ensure Pearl has the most recent update applied.
2. Windows 7 users, turn UAC off (see page 2.)
3. CRITICAL STEP: Do a search on the hard drive of the workstation (usually the C:\ drive, be sure to include hidden files
and folders) and rename any existing copies of MSSOAP30.dll to MSSOAP30_14.DLL.
Make sure no one else is in Pearl
Open the Pearl database

Press Ctrl+G to open the Visual Basic editor with the cursor in the Immediate window

N o ouv ok

From the menu in the VB editor go to Tools > References

m Eile Edit y'ew nsert Debug Run | Tools | Add-Ins Window Help
‘B o~ [ T s W I IR €Y References... @
-

L DR Macros..

e — | Options...
| ' Puart (Puart) Pearl Properties...

* - e® A se e AR .

. o ption o Digital Signature...

8. Inthe References dialog box, uncheck “Microsoft Office Soap Type Library v3.0”, Click OK

Available References: 0K
v Visual Basic For Applications - Cancel

¥ Microsoft Access 14.0 Object Library =
¥ Microsoft DAO 3.6 Object Library =

W Microsoft XML, v3.0 Browse...
I'-'Ilcmsoft Office Soap Tvpe Library v3.0

A pall S bW i Yepe L 1*|
-
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9. From the menu in the VB editor, click Save

I " Fn ¥ l
T ——

i Save Pearl (Ctrl+S)

['l‘-r. tetonpgyright 1Y

10. From the menu in the VB editor go to Tools > References again

Options...

Pearl Properties...
Digital Signature...

11. Click Browse to open the Add Reference dialog box

Available References: oK

v Visual Basic For Applications

F
Microsoft Access 14.0 Object Library

Microsoft DAQ 3.6 Ob

A

crasoft XML, v3.0

b el pagrw ) Tpe B ll
Acahe Accem ) D Tape Lbeery

<
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12. Click on the drop down and browse to your ...\Pearl\System folder

Name . Type Size
| Speed Test File Folder
| Sunspot File Folder
}. SWIF File Folder
| System R File Folder
<l m J »

13. a) Double-click to open the System folder
b) Type “MSSOAP30.dIl” in the File name
c) Click Open

Lookin: | | System v| & B ¥ Ev
Name

% geocoder.dll

% msldbusr.dil

% MSSOAP30.DLL

2 msver70.dll
‘| m | »

R

Files of type: | Type Libraries (".ob:"tib:" dl) -] Cancel
Help

14. In the References dialog box, click OK

Available References:

L Microsoft IMAPI2 File System Image Creator -
[ Microsoft InfoPath 3.0 Type Library
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15. Again, from the menu in the VB editor, click Save

I "Fear

16. Close the Visual Basic editor and close Pearl

17. Open the Pearl database
Note: If Pearl does not open normally, see section B below and contact Bromelkamp Support at (877) 767-6703 or

support@bromelkamp.com.
18. Windows 7 users, turn UAC back to the original setting (see page 7.)
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